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Chapter 1

About the User Guide

The IBM Sterling Control Center User Guide is for operations staff who use IBM® Sterling Control 
Center to monitor server activity and oversee the routine functioning of Sterling Control Center. 
This guide assumes that you are familiar with your server hardware and software environment.

Once you are ready to begin using Sterling Control Center, the IBM Sterling Control Center User 
Guide helps you with the following tasks:

Task For More Information, See

Access the IBM Sterling Control Center 
Console and use the main IBM Sterling 
Control Center and web consoles

Use the Console on page 9

View server status Monitor Status on page 35

View processing activity Monitor Server Activity on page 21

View alerts Monitor Alerts on page 41

Restart and resume a business process Restart and Resume a Sterling B2B Integrator Business 
Process on page 32

Delete, suspend, or release a Sterling 
Connect:Direct Process

Manage Sterling Connect:Direct Processes on page 31

Stop a Sterling Control Center server Stop Sterling Connect:Direct Servers on page 19

View server license information View License Information on page 49

Customize layout views Customize Layout Views on page 51

Change a Sterling Control Center password Change Passwords on page 47

Access other applications including IBM® 
Sterling B2B Integrator, IBM® Sterling File 
Gateway, and IBM® Sterling Connect:Direct 
Browser User Interface

Interface with Other Systems on page 55

Troubleshoot user problems User Troubleshooting on page 57
IBM Sterling Control Center User Guide 7
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Chapter 2

Use the Console

Start the Sterling Control Center Console
To log into the IBM® Sterling Control Center console, begin by starting it. You can start the 
console from the computer where the Sterling Control Center engine is installed or from the IBM 
Sterling Control Center Launch Page. The Web Console can also be started from the IBM Sterling 
Control Center Launch Page.

Starting the Console through Java Web Start from the IBM Sterling Control Center Launch Page 
gives you full Console functionality. The IBM Sterling Control Center Web Console gives access 
to many Console features without installing Console-related files on your computer. The feature set 
available through the Web Console, however, is a subset of all features. 

Log In To the Console 
You can log into the console from three locations:

• On the computer where the Sterling Control Center engine is installed
• Using Java Web Start
• Using the Web Console

Log In From the Computer Where the Engine is Installed
To log in from the computer where the engine is installed:

1. Ensure that the Sterling Control Center engine is running. Contact your system administrator if 
unsure.
IBM Sterling Control Center User Guide 9



Chapter 2   Use the Console
2. Do one of the following:
• Double-click the Console-IBM Sterling Control Center v5.3 icon from the desktop.
• In UNIX, from a command line, after setting the display, change to the 

SCCInstallDirectory/bin directory and type sh runConsole.sh.
• In Microsoft Windows, click Start > All Programs > IBM Sterling Control Center v5.3 

> Console - IBM Sterling Control Center v5.3.
3. In the Login screen that displays, enter the following information: 

• Host name of the computer where the Sterling Control Center engine is installed. This 
entry can be either a DNS host name or an IP address. 

• Port number that the Sterling Control Center engine is configured to listen on. The default 
nonsecure port is 58080.

• Select HTTPS if you are signing onto the engine with a secure connection. If Sterling 
Control Center has not been configured for an HTTPS console-engine connection, this 
field cannot be selected. Refer to Configure a Secure Connection on page 35 in the IBM 
Sterling Control Center Getting Started Guide.

• Your Sterling Control Center user name and password. The password is case sensitive. 
The default user ID and password are admin. 

Log In Via Java Web Start
To log in to Sterling Control Center via Java Web Start:

1. In the Web address field of your Web browser, enter the host and port number for the IBM 
Sterling Control Center Launch Page. 

2. From the Launch Page, click IBM Sterling Control Center Console (Small, Medium, or 
Large configuration).

3. In the Login screen that displays, type the following information: 
• Host name of the computer where the Sterling Control Center engine is installed. This 

entry can be either a DNS host name or an IP address. 
• Port number that the Sterling Control Center engine is configured to listen on. The default 

nonsecure port is 58080.
• Select HTTPS if to sign onto the engine with a secure connection. If Sterling Control 

Center has not been configured for an HTTPS console-engine connection, this field cannot 
be selected. Refer to Configure a Secure Connection on page 35 in the IBM Sterling 
Control Center Getting Started Guide.

Note: The default port for the HTTPS connection is 58081.

Note: After you log in using the default user ID and password, you should change the password.

Note: See your system administrator for these values.
10 IBM Sterling Control Center User Guide



Log Into the Web Console
• Your Sterling Control Center user name and password. The password is case sensitive. 
The default user ID and password are admin. 

Log Into the Web Console
To log into the Web Console:

1. In the Web address field of your Web browser, enter the host and port number for the IBM 
Sterling Control Center Launch Page. The default nonsecure port is 58082. 

2. On the Launch Page, click IBM Sterling Control Center Web Console.
3. On the login page that displays, type your user ID and password and click Login. 

Reconnect to the Engine after a Service Interruption
If for any reason the Console is disconnected from the Sterling Control Center engine, it 
automatically attempts to reconnect. A message window displays:

The message includes the time when the connection was lost. The Console continues attempting to 
reconnect until a connection is established, or until you click Exit Console. 

When the connection is reestablished, the Console checks to make sure that your login credentials 
are still valid. If not, a second message window gives you the opportunity to log in again or exit the 
Console. 

Note: The default port for the HTTPS connection is 58081.

Note: After you log in using the default user ID and password, you should change the password.

Note: If you experience access-time problems using Java WebStart in Microsoft Windows, do 
the following:

1 Click Start > Run... 
2 Type javaws -viewer in the Open field and click OK.
3 Select the Direct Connection option from the Java Control Panel Network Settings.

Note: Whenever you upgrade Sterling Control Center or install a patch, it is recommended that 
you empty your Webstart and browser cache. 
IBM Sterling Control Center User Guide 11



Chapter 2   Use the Console
Understand the IBM Sterling Control Center Console Window
The IBM Sterling Control Center Console window enables you to monitor Process activity. It also 
enables an administrator to perform a variety of tasks, such as creating and maintaining users, rules, 
actions, service level criteria (SLCs), and email lists, and configuring servers. 

See the following figure.

The menu bar contains the main menu items you use in performing most Sterling Control Center 
tasks.

Below the menu bar, on the left side, is the listing of managed servers and server groups that have 
been added to Sterling Control Center. 

Arranged horizontally along the bottom of the Sterling Control Center window are the memory 
monitors, which give a visual picture of how much available memory is being used by both the 
Console and the Sterling Control Center engine, and current time settings, including Coordinated 
Universal Time (UTC) as well as engine, local, and preferred times. 

The menu bar

The servers 
added to Sterling 
Control Center

UTC time (Coordinated Universal Time), the time on the server where the engine is installed, the time where the 
GUI is installed, the preferred time (as set in Time Preferences), and the current user ID. A lock icon indicates a 
secure GUI-engine connection. 

The work area

Console and 
Engine memory 
monitors

Find function
12 IBM Sterling Control Center User Guide



Understand the IBM Sterling Control Center Console Window
As with many windows, dialogs, and listings in the interface, the Sterling Control Center window 
features a Find function. By entering search text in this function, you can find occurrences of that 
text in the current window. Occurrences are highlighted in green. Click the up or down arrow to find 
the next (or previous) occurrence. 

The work area is where the various available monitors and listing screens display. After displaying 
one or more monitors or listings, you can arrange them visually. 

To arrange listings or monitors in the work area:

Click Window and make a selection. 

• Tile Vertically arranges the listings or monitors to be long in the vertical dimension.
• Tile Horizontally arranges them to be wide horizontally. 
• Cascade arranges them in a cascaded presentation, one behind the next. Click a window to 

bring it to the front. 

Server and Group Tabs
The Servers and Groups tabs show the servers defined in Sterling Control Center.

Clicking the Servers 
tab lists Sterling 
Control Center 
servers in 
alphabetical order by 
server type.
IBM Sterling Control Center User Guide 13



Chapter 2   Use the Console
Right-clicking an object in the server listing displays a number of options to select from, as shown 
in the following illustration.

Note: The functions you can perform depend on the object selected and your Sterling Control Center role 
permissions. Functions not available due to role restrictions appear dimmed.

Clicking the Groups 
tab lists Sterling 
Control Center servers 
in groups you have 
defined.
14 IBM Sterling Control Center User Guide



Understand the IBM Sterling Control Center Console Window
Server Icons
The server icons have different meanings:

Icon Definition

A Sterling Connect:Direct server that Sterling Control Center has successfully contacted.

An IBM® Sterling Connect:Enterprise® server that Sterling Control Center has successfully 
contacted. 

An IBM® Sterling B2B Integrator server that Sterling Control Center has successfully contacted.

A Sterling B2B Integrator node that is part of a Sterling B2B Integrator cluster and that Sterling 
Control Center has successfully contacted.
An IBM® Sterling Connect:Direct® File Agent node (listed under its associated Sterling 
Connect:Direct server) that Sterling Control Center has successfully contacted.

A managed FTP server contacted by Sterling Control Center.

Indicates that an alert was generated on the server. 

Indicates that there is a license message for the server. 

Indicates that Sterling Control Center cannot sign on to the server due to a user ID or password 
problem or that the server is at an unsupported level. For an FTP server, can also mean that the 
log file specified is either invalid or does not exist.

Indicates that the server was previously contacted by Sterling Control Center, but is currently 
offline.
Note: A server name in red also indicates that the server was previously contacted by Sterling 

Control Center but is currently offline, regardless of the icon displayed.

Indicates that a Sterling B2B Integrator cluster is down. 

Indicates that at least one, but not all, of the Sterling B2B Integrator nodes in the cluster is down.

Indicates that the server was never contacted by Sterling Control Center. The server may be 
offline, or the server IP address or port number may be incorrect in Sterling Control Center. 

Indicates that the server is unavailable, but still has unprocessed alerts. 

Indicates that monitoring of the server is currently paused. 
IBM Sterling Control Center User Guide 15



Chapter 2   Use the Console
Use the Sterling Control Center Web Console
When you log into the Sterling Control Center Web Console, the initial Server List displays to 
enable you to drill down and select only those servers you need to monitor at one particular time:

Use the navigation buttons (First, Previous, Next, Last)  to page through displayed information and 
the Filter button to further define and limit the information displayed in the Console. 

The Web Console allows you to do the following tasks.

• View and handle alerts using the Active Alerts and Handled Alerts monitors
• View server activity using the Queued Activity and Completed Activity monitors
• Check status using the Server Status, Daemon Status, and Adapter Status monitors
• Change Auto Refresh settings that control how frequently open monitors are automatically 

refreshed
• Manually refresh open monitors
• View a server’s properties
• View statistics related to server activity 
• Run and view reports in PDF that have been set up by an administrator
There are some differences in the way you interact with Sterling Control Center through the Web 
Console in comparison to the other types of Console access:

• With the Web Console, you left-click with the mouse to make all selections. Right-clicking to 
display contextual menus is not available. 

• The menu items and selections available via the Web Console comprise a subset of Console 
features.

Note: Your role may limit access to some features.
16 IBM Sterling Control Center User Guide



Set Console Preferences
Set Console Preferences
Console Preferences determine how time is displayed and how often monitors are automatically 
refreshed on your Console. These settings are associated with your user ID and are employed 
whenever you log into Sterling Control Center.

The Time Preferences settings determine how time is displayed on the Sterling Control Center 
Console. Time preferences are set for all Sterling Control Center functions you perform or view 
from the Console. Auto Refresh settings determine how often open monitors are automatically 
refreshed. 

To set preferences:

1. Select Control Center > Console Preferences, 
2. Click on the Time Preferences tab and select a time display:

3. Click Update. The new time preferences take effect immediately. 
4. Click on Auto Refresh Settings and select one of the following:

• To use the default system setting for all users, select Use System Setting. The current 
setting is displayed in seconds. 

• To set your auto refresh setting here (and override System Settings), select Change Auto 
Refresh To and enter a new auto refresh setting in seconds. 

5. Click Update. The new auto refresh setting takes effect immediately. 

Display Description

UTC Displays the time in Coordinated Universal Time. (Instead of using the 
acronym CUT, UTC is the accepted international acronym for Universal Time, 
Coordinated, which uses the same letters as the French acronym for Temps 
Universel Coordonné, TUC.) 
Note: Since UTC never changes for daylight saving time (DST), do not 

use UTC for your rule or SLC schedules. Otherwise you most likely 
will need to manually adjust your schedules to compensate for DST.

Local Time Displays the time from the computer where the IBM Sterling Control Center 
Console is installed.
If you use local time display, verify that the Console is displaying the correct 
time zone. If the time zone is incorrect, manually select the correct time zone 
from the Specific Time Zone list box, or adjust your system’s time zone 
value, as that is where the Console obtains this information. 

Engine Time Displays the time on the Sterling Control Center engine computer.

Specific Time Zones Displays the time selected from the list box of standard time zones. 
IBM Sterling Control Center User Guide 17
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Chapter 3

Stop Sterling Connect:Direct Servers

You can stop a Sterling Connect:Direct server from the IBM Sterling Control Center console if your 
role has permission to manage servers and groups. If your role does not have the requisite 
permission, the Stop Server option appears dimmed.

To stop a Sterling Connect:Direct server:

1. Right-click the server you want to stop.
2. Select Stop Server. The Stop Server window displays with the following termination types:

3. Select the Termination Type and click OK. 

Termination Type Description

Quiesce after active 
processes complete.

Stops the server when all executing Processes are complete. No new 
Processes are started.

Terminate processes at end 
of step.

Stops all Processes after the executing step is complete. Writes 
statistics records, closes files, and shuts down the server.

Immediate orderly 
shutdown.

Stops all activity, terminates processes and connections, writes 
statistics records, closes files, and shuts down the server.

Force termination now. Forcibly terminates the server. No attempt is made to terminate 
executing processes or write statistics records. Use this type only for 
emergency terminations or when a problem occurs.
IBM Sterling Control Center User Guide 19
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Chapter 4

Monitor Server Activity

Sterling Control Center offers several alternatives for monitoring managed server activity, as well 
as options for drilling down into that activity.

This chapter covers the following procedures:

• View Servers and Server Groups
• View Server Activity
• Monitor File Agents
• View the System Activity Graph
• Customize the Process Activity Display
• View Process Properties
• Monitor Processing Against Service Level Criteria
• View Process Statistics
• View Process Statistics for Servers
• Manage Sterling Connect:Direct Processes
• Manage Sterling B2B Integrator Business Processes
Your role must have permission to access a particular function. If it does not, that function appears 
dimmed.

View Servers and Server Groups
You can view listings of servers and server groups using the Server List View and Server Group 
View features of Sterling Control Center. They take advantage of the filtering capabilities of 
Sterling Control Center to help you isolate the information you need. 

You can also add, delete, duplicate, and view and update the properties of servers from these 
listings. 
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To get a list view of servers:

1. Click Monitor > Server List View. A listing of folders consisting of the major server types 
supported by Sterling Control Center (Sterling Connect:Direct, Sterling Connect:Enterprise, 
Sterling B2B Integrator, and File Transfer Protocol) displays.

2. To explode the view, click the double-headed down arrow.
3. To drill down into a folder, right-click it and select Server List View.
4. To move up in the hierarchy, click the double-headed up arrow. 
5. To view a subset of servers, right-click any object in the server tree on the left of the Sterling 

Control Center window and select Server List View. 

To get a list view of server groups:

1. Click Monitor > Server Group View. A listing of group folders displays.
2. To explode the view, click the double-headed down arrow.
3. To drill down into a folder, right-click it and select Server Group View. 
4. To move up in the hierarchy, click the double-headed up arrow. 

You can perform other operations on the servers in these listings, including adding, duplicating, and 
deleting servers, and viewing and changing their properties. See Managing Servers in the IBM 
Sterling Control Center System Administration Guide.

Server List View Column Definitions
The columns in the Server List View are defined in the following table. 

Field Definition

Name The name that identifies a server in the Sterling Control Center window, up to 25 
characters. The name/alias must be unique within Sterling Control Center. 
Typically this is the Sterling Connect:Enterprise, Sterling Connect:Direct, Sterling 
B2B Integrator, or File Transfer Protocol server name. 

Type Server type: Sterling Connect:Enterprise, Sterling Connect:Direct, Sterling B2B 
Integrator, or File Transfer Protocol.

Server Address The API address used to establish a session with the Sterling Connect:Direct or 
Sterling Connect:Enterprise server.

API Port The API port used to establish a session with the Sterling Connect:Direct, Sterling 
Connect:Enterprise for UNIX, or FTP server. For Sterling Connect:Enterprise, the 
listening port for cmusvid. Sterling Connect:Direct default is 1363; must be 
between 1024 and 65535. FTP default is 21; must be between 1 and 65535.

Secure+ Enabled Whether Sterling Connect:Direct Secure Plus is enabled on this server. 
Values=Yes, No, or Unknown.

Monitored Business processes are being monitored by Sterling Control Center (Y/N). 

Managed Server is managed by Sterling Control Center (Y/N). (Sterling Connect:Direct.)
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View Server Activity
The Process Activity Monitors allow you to view up to the last 200 completed Processes 
(configurable by the administrator) and a limited number of queued Processes on one server, a 
server group, or all managed servers of one or more types. The Queued Process Activity Monitor 
shows server activity at a specific time. You can open multiple Process Activity Monitor windows, 

Monitor Rest Time The amount of time Sterling Control Center waits before polling the server to 
check status and collect statistics. Values range from 1–3600 seconds (60 
minutes) for Sterling Connect:Direct and FTP servers (5–3600 seconds for 
Sterling Connect:Direct for Windows and Sterling B2B Integrator), and 1–60 
minutes for Sterling Connect:Enterprise for UNIX. Setting a lower rest time 
updates the display of status more frequently but may affect performance.

Protocol The web protocol (HTTP or HTTPS) for Sterling B2B Integrator.

Connection Timeout The amount of time the Sterling Control Center engine waits for a response from a 
server it has attempted to contact. 

Server Time Zone ID The time zone where the managed server is located. This field is provided for 
cases in which the server’s date/time settings are wrong, or a region’s changeover 
to Daylight Saving Time differs from the national norm. This field also shows the 
difference between the time zone and Coordinated Universal Time (UTC).

Ignore Server Time 
Zone ID

Ignore the time zone provided by the server.

Operating System The server operating system.

Server Version Version of server installed. 

License Expiration Date the server license is slated to expire. 

License Expiry 
Notification

Number of days in advance to notify user that the server license is about to expire.

SNMP Listener 
Address

If your Sterling Control Center engine has a dual-homed IP stack (e.g., multiple 
adapters), specify the IP address to which to bind. Otherwise Sterling Control 
Center binds to any available address. 

SNMP Listener Port The 1- to 5-digit port number on which Sterling Control Center is to listen to 
receive traps from the server. 

Heartbeat Interval Interval in seconds within which SNMP trap must be received for server to be 
considered up. Connect:Enterprise or Connect:Direct Select.

SERVER_DATA_1-10 Server Metadata 1-10. The server metadata fields are user-definable fields for 
writing metadata rules and actions, and for reporting purposes.

Web Service Port The port for the Sterling B2B Integrator web service.

Dashboard Port The port for accessing the Sterling B2B Integrator dashboard.

Field Definition
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Complete and Queued, including more than one window per server in order to view both queued 
and completed Processes. 

To view server activity, take one of the following actions:

1. To view activity on one server or server group:
• Right-click the server or server group. 

• Select Queued Process Activity or Completed Process Activity. 
2. To view activity on multiple servers or server groups:

• Select the servers or server groups. (Shift-click to select contiguous servers or server 
groups. Ctrl-click to select non-contiguous servers or server groups.)

• Right-click one of the selected servers or server groups, then select Queued Process 
Activity or Completed Process Activity. 

3. To view activity on all managed servers of one type:

• Right-click the Sterling Connect:Direct icon  or the SI icon . 

• Select Queued Process Activity or Completed Process Activity.
4. To view activity on all managed servers: 

• Ctrl-click the Sterling Connect:Direct and Sterling B2B Integrator icons, as applicable.
• Right-click one of the icons and select Queued Process Activity or Completed Process 

Activity.

Note: Because Sterling Control Center does not “know” about FTP or Sterling Connect:Enterprise activity 
until that activity has occurred, the Queued Process Activity Monitor is disabled for FTP and 
Sterling Connect:Enterprise servers. 

Note: In the Queued Process Activity Monitor, users who have roles with data visibility group restrictions 
will only have access to the process steps associated with their data visibility group. As a result, data 
visibility group restricted users cannot delete, suspend, or release queued processes. In the 
Completed Activity Monitor, users who have data visibility group restrictions will see only the 
completed processes tagged for the data visibility groups associated with their role. However, 
unrestricted users will see the maximum number (up to 200) configured by the administrator. 
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Refresh the Process Activity Monitors
If you have the appropriate role permission level, any open monitors automatically refresh based on 
the value stored in System Settings. (To view the value, select IBM Sterling Control Center > 
System Settings > Console Settings tab > Default Console Auto Refresh System Setting in 
seconds.) 

Any user can manually refresh the Process data shown on the Completed and Queued Process 
activity monitors. 

Automatic refreshing affects all open monitor instances. Manual refresh affects all open monitors 
with data for the server or server groups that appear in the monitor on which you click the Refresh 
button. 

To manually refresh the activity monitors, do one of the following:

• On a Queued or Completed Process activity monitor, click Refresh .

• Press F5.
• Select Monitor > Manual Refresh. 

Pause and Resume the Process Activity Monitors
You can pause the monitoring of one or more servers, server groups, server types, or all servers 
monitored by Sterling Control Center. Pausing does not affect the server or servers themselves, only 
their monitoring. Pausing can be useful if, for example, you want to bring down servers for 
maintenance without triggering server-down messages on those servers. 

After pausing monitoring, you can resume monitoring. 

To pause monitoring:

1. Right-click the server and select Pause Monitoring.
2. Click OK.

Monitoring of the server is paused.

To resume monitoring: 

1. Right-click the server and select Resume Monitoring. 
2. In the window that displays, select whether you want monitoring to resume from the original 

pause point or starting now. 
If you choose Now, no data will be collected from the node between the time at which 
monitoring was paused and the present. 

3. Click OK. 

Note: For information on setting the default auto refresh value, see Sterling Control Center Settings in the 
IBM Sterling Control Center System Administration Guide.

Note: For SNMP-type servers (Sterling Connect:Direct Select, z/OS FTP Server, and Sterling 
Connect:Enterprise for z/OS), only the Now option is viable.
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Take a Process Snapshot
You can view a snapshot of the activity for the Processes listed in the Process Activity Monitors.

To view a snapshot of activity: 

1. Right-click in the Queued Process Activity Monitor or Completed Process Activity 
Monitor window. 

2. Select Process Snapshot. The Process Snapshot window displays information for queued and 
completed Processes. Information for up to 100 completed Processes or file transfers can be 
displayed (configurable by the system administrator). 

3. Right-click an item to see statistics or Process properties.
4. Sort on a column by clicking the column title. Toggle between ascending and descending 

order by clicking repeatedly.

Monitor File Agents
If a monitored Sterling Connect:Direct server has associated file agents set up to submit processes 
to it, you can monitor those file agents if the following conditions have been met:

• The Sterling Connect:Direct server’s connections setting does not have “Do not monitor 
associated File Agents” selected.

• The Sterling Connect:Direct File Agent system setting for the engine has been configured 
properly.

• The Sterling Connect:Direct File Agent has been configured to send traps to Sterling Control 
Center properly.

To monitor completed activity for a file agent associated with a managed Sterling Connect:Direct 
server: 

1. In the node tree on the Sterling Control Center main window, right-click the Sterling 
Connect:Direct File Agent icon.

2. Select Completed Sterling Connect:Direct File Agent Activity. 

Note: If you are running a Sterling Connect:Direct Process with numerous Copy steps, Sterling 
Control Center may not show current status due to the large number of statistical records 
generated. You can disable the collection of Sterling Connect:Direct step statistics for a server. 
See Server Field Descriptions in the IBM Sterling Control Center System Administration Guide 
for instructions. Also, fast-running Processes may complete before they can be shown in the 
Queued Process Activity Monitor.

Note: You can only monitor completed activity, not queued activity. 
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View the System Activity Graph
You can obtain a graphical view of server and server group activity using the System Activity 
Graph. The System Activity Graph depicts Processes currently executing (in the EXEC queue) for 
all servers you have permission to view. You can open multiple Activity Graph windows. 

In the System Activity Graph, unmanaged servers communicating with a managed server or group 
are represented by a cloud. As activity increases between the managed entity and the unmanaged 
server or servers, the cloud grows progressively more shaded. 

You can toggle a server between collapsed and expanded modes. In expanded mode the cloud that 
represents unmanaged servers is replaced by an icon for each individual unmanaged server. 

You can manage the way a server’s activity levels are represented through Server Properties. You 
can change the system-level default for representing activity levels through System Settings. See 
Server Field Descriptions and Sterling Control Center Settings, in the IBM Sterling Control Center 
System Administration Guide

To get a graphical view of activity for selected servers or server groups:

1. Select servers, server groups, or server types by doing one of the following: 
• Click a single server or server group.
• Shift-click to select contiguous servers or server groups. 
• Ctrl-click to select non-contiguous servers or server groups.
• Click the Connect:Direct, Connect:Enterprise, File Transfer Protocol, or Sterling B2B 

Integrator icon.
2. Right-click the icon or icon combination and select System Activity Graph.

To toggle a server icon between expanded and collapsed mode:

1. Right-click the server icon.
2. Select Expand or Collapse. 

To view or modify a server’s properties:

Double-click the server’s icon.

To view the individual servers represented by a cloud icon:

Double-click the cloud.

To get a graphical view of activity for the entire viewable system:

Select Tools > System Activity Graph. 

Note: For details on server properties, see Manage Servers in the IBM Sterling Control Center System 
Administration Guide.
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Customize the Process Activity Display
The Process Activity Monitors provide a large set of information about servers. You can create 
customized views to display only selected columns. Refer to Customize Layout Views on page 51 
for instructions on customizing the Process Activity Monitors.

View Process Properties
You can view the properties associated with a Process. The properties displayed depend on the 
server type and whether the Process is queued or completed. See Keys and Fields in the IBM 
Sterling Control Center System Administration Guide for descriptions of these property fields.

To view Process properties:

1. Open either Process Activity Monitor window (Queued or Completed).
2. Double-click an item to display the Properties window. 

3. Expand the window to view any hidden information. 
4. Click Close when finished.
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Monitor Processing Against Service Level Criteria
Service level criteria (SLCs) are performance objectives that require processing to occur within a 
certain time window. For example, a Process may need to begin by 8:00 p.m. and end by 8:30 p.m. 
Another example is a file transfer that must run no longer than 10 minutes. 

You can use Sterling Control Center to monitor processing against an SLC. In Sterling Control 
Center, users with appropriate permissions can define the SLC requirements and what processing 
to monitor, and whether Sterling Control Center generates an alert when an SLC is not met. 

To monitor processing against an SLC:

1. Open either Process Activity Monitor window (Queued or Completed). If processing has not 
been performed within the parameters of an SLC and a rule has been created to generate an 
SLC alert, an SLC event icon (such as ) is displayed in the SLC Icon field.

2. To view more detail about an SLC-generated alert from one of the activity monitors, 
right-click the item and select Alerts.

View Process Statistics
You can view statistics related to any Process listed in the activity monitors. The Statistics Viewer 
shows Process statistics by log date and time. The statistics displayed depend on the server type. 
See Keys and Fields in the IBM Sterling Control Center System Administration Guide for 
descriptions of the Statistics Viewer and Statistics Detail fields. 

To view Process statistics:

1. From one of the Process activity monitors, right-click a Process and click Select Statistics to 
display the History - Statistics window.

2. Pick a report type: Detail or Summary.
3. To limit the number of Processes retrieved, specify filtering criteria by adjusting one or more 

of the following items:
• Number

• Name
• Server

Note: If necessary, refer to the documentation for your IBM Sterling product for troubleshooting 
information.

Note: You can also go to the Alerts Monitor to monitor SLC activity. See View Alerts on page 43.

Note: To see detailed statistics records for all previous runs of the Process, delete the Number 
Key by clicking it and selecting the blank value at the top of the list.
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4. To further limit the number of Processes retrieved, specify a value in the Max Records 
Returned field.

5. To include Processes in the Staging database, check the Include Staging DB Data option.
6. Click OK.

The Statistics Viewer window displays with the detailed or summary statistics you requested.
7. To open a Statistics Detail window, double-click a statistics record in the Statistics Viewer. 

You can display data for the next or previous Process event by clicking or .

View Process Statistics for Servers
You can view process statistics related to one or more servers, server groups, or a server type 
(Connect:Direct, Connect:Enterprise, File Transfer Protocol Server, or Sterling B2B Integrator). 

To view Process statistics for a server, server group, or server type:

1. Right-click an item (server, server group, or server type) and select Select Statistics.
2. Choose a Type: Detail or Summary. 
3. To limit the number of records retrieved, specify filtering criteria.

4. To further limit the number of records retrieved, specify a value in the Max Records 
Returned field.

5. To include items in the Staging database, check the Include Staging DB Data option.
6. Click OK.

The Statistics Viewer window displays with the detailed or summary statistics you requested.
7. To open a Statistics Detail window, double-click a statistics record in the Statistics Viewer. 

You can display data for the next or previous statistic record by clicking or 

.

Note: Users who have roles with data visibility group restrictions will only see process statistics 
associated with their data visibility groups.

Note: You must specify at least one server in the matching criteria. 
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Manage Sterling Connect:Direct Processes
You can take various actions on a queued Sterling Connect:Direct Process, including deleting, 
suspending, or releasing it. 

Delete a Queued Sterling Connect:Direct Process
By deleting a process from the queue, you prevent it from ever being processed. 

To delete a queued Sterling Connect:Direct Process:

1. Open the Queued Process Activity Monitor window.
2. Right-click the Process you want to delete.

3. Select Delete to display the Delete Process window.
4. Click OK.

Suspend a Queued Sterling Connect:Direct Process
Suspending a Process keeps it from being processed when it reaches the top of the queue. Releasing 
it later ends the suspension. 

To suspend a queued Sterling Connect:Direct Process:

1. Open the Queued Process Activity Monitor window.

2. Right-click the Process you want to suspend.

3. Select Suspend and click OK.

Release a Suspended Sterling Connect:Direct Process
Suspending a Process keeps it from being processed when it reaches the top of the queue. A 
suspended Process is placed in the Hold queue. Releasing a suspended Process removes it from the 
Hold queue and frees it to be processed. 

To release a suspended Sterling Connect:Direct Process:

1. Open the Queued Process Activity Monitor window.

Note: Users who have data visibility group restrictions cannot delete, suspend, or release queued processes 
because they may not own all the Process steps.

Note: Processes in the Exec queue cannot be deleted.

Note: Only Processes in the Exec queue can be suspended.

Note: You may not be able to suspend Processes that run very quickly, because the Process may 
complete before the suspend request can be processed.
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2. Right-click the Process you want to release.

3. Select Release.
4. Click OK to release the Process.

Manage Sterling B2B Integrator Business Processes
You can take various actions on a queued IBM® Sterling B2B Integrator business process, 
including restarting, resuming, or deleting it. 

Restart and Resume a Sterling B2B Integrator Business Process
When you discover a business process whose state is waiting, interrupted, or halted in a Completed 
Process Activity Monitor, or you have stopped the business process for some reason, you can 
perform one of the following functions:

• Resume—Continues a business process from the last step fully completed (including 
full-configured persistence). The business process retains its original instance ID. Use this 
function when the error is related to services, for example, if a service is unavailable 
unexpectedly and a business process using that service stops at that point. Another example 
could be if you stopped a business process to correct a problem before it continued. After the 
service is restored and active, you can resume the business process.

• Simple restart—Starts a new instance of the same business process from the beginning (with 
the same document). The new business process receives a new instance ID.

To resume or restart a business process:

1. Display the Completed Process Activity Monitor (right-click the Sterling B2B Integrator 
server and select Completed Process Activity).

2. Right-click the business process and select one of the following actions:
• To resume a business process from the failed step, right-click the process and select 

Restart > Resume.
• To start a business process that originally ran successfully from the first step, right-click 

the process and select Restart > Simple.

Delete a Sterling B2B Integrator Business Process Entry 
Occasionally a Sterling B2B Integrator business process remains in the Queued Activity Monitor 
long after it has actually completed when Sterling Control Center is unable to associate statistical 
information received with the business process. When this happens, you can manually delete the 
business process from the Queued Process Activity Monitor. 

Note: Processes must be in the Hold Queue to be released.
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To delete a queued Sterling B2B Integrator business process entry:

1. Display the Queued Process Activity Monitor (right-click the Sterling B2B Integrator server 
and select Queued Process Activity).

2. Right-click the process and select Advanced > Clear Process.

Note: Deleting a Sterling B2B Integrator Process from the Queued Process Activity Monitor affects 
only the monitor display, not the Sterling B2B Integrator Process itself.
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Chapter 5

Monitor Status

Sterling Control Center allows you to monitor the status of Sterling Connect:Direct, Sterling 
Connect:Enterprise, File Transfer Protocol, and Sterling B2B Integrator servers, as well as Sterling 
B2B Integrator adapters and Sterling Connect:Enterprise for UNIX daemons. This chapter 
addresses status monitoring. It consists of the following sections subtopics: 

✦ Monitor Server Status
✦ Monitor Sterling B2B Integrator Adapter Status
✦ Monitor Sterling Connect:Enterprise Daemon Status

Monitor Server Status
The Server Status Monitor displays summary information about current server activity. The exact 
information displayed depends on server type. 

To view the status of a server or server group: 

1. Right-click the server or server group.
2. Select Server Status Monitor.

To view the status of multiple servers or server groups: 

1. Select the servers or server groups. (Shift-click to select contiguous servers or server groups. 
Ctrl-click to select non-contiguous servers or server groups.)

2. Right-click one of the servers or groups and select Server Status Monitor.

To view the status of all managed servers of one type:

1. Right-click the Sterling Connect:Direct icon , the Sterling Connect:Enterprise icon , the 
File Transfer Protocol icon , or the Sterling B2B Integrator icon .

2. Select Server Status Monitor (or, for Sterling B2B Integrator, Adapter Status Monitor).
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To view the status of all managed servers:

1. Ctrl-click the Sterling Connect:Direct, Sterling Connect:Enterprise, Sterling Control Center 
FTP Managed Server, and Sterling B2B Integrator icons, as applicable. 

2. Right-click one of the selected server type icons and select Server Status Monitor.

The Server Status Monitor window gives a dynamic summary of managed server activity. You 
can open multiple Server Status Monitor windows.

This window shows the following information:

✦ Server status icons. See Server Icons on page 15 for a description. 
✦ The server’s Sterling Control Center name/alias.
✦ The current number of high, medium, and low severity alerts on the server.
✦ The version of Sterling Connect:Direct, Sterling Connect:Enterprise, File Transfer Protocol 

server, or Sterling B2B Integrator software running on the server, if the server supports 
sending this information to IBM Sterling Control Center.

✦ For data visibility restricted users, the current number of high, medium, and low severity alerts 
will be only for the alerts for which they have visibility. For example, if there are 5 global high 
alerts and 2 dvg=payroll high alerts, a user restricted to a data visibility group of payroll would 
show high count of 2; a non-data visibility group-restricted user would show a high count of 7.

✦ License information, including:
The date when the current Sterling Connect:Direct, Sterling Connect:Enterprise, or 
Sterling B2B Integrator software license expires.

License information is displayed only if the Sterling Connect:Enterprise, Sterling 
Connect:Direct, or Sterling B2B Integrator release on the server supports sending license 
information to Sterling Control Center. The license expiration date is not shown for 
Sterling Connect:Enterprise servers using an emergency key or keys with no expiration 
date. 

The number of days prior to license expiration that an alert is generated.

The number of concurrent sessions permitted by the license or the number of accounts 
defined.

Note: You can also use the menu item Monitor > Server Status Monitor to display server status 
for any of the above selected combinations. 
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✦ The following information is displayed only for Sterling Connect:Direct and Sterling B2B 
Integrator servers:

The maximum number of concurrent sessions that have occurred on the server (in the 
High column).

The number of times that this server reached the maximum number of concurrent sessions 
(in the # column).

The last date and time that the server reached the maximum number of concurrent sessions 
(in the Last Occurrence column).

The number of executing and non-executing Processes.

Monitor Sterling B2B Integrator Adapter Status
Sterling Control Center monitors the status of Sterling B2B Integrator adapters running on Sterling 
B2B Integrator servers that have been added to Sterling Control Center. Sterling Control Center 
displays summary information about these adapters through the Adapter Status Monitor. You can 
also access properties information for an adapter, as well as information about its perimeter server. 

Sterling Control Center does not monitor Sterling B2B Integrator protocol adapters when those 
adapters are not actively monitoring business processes or protocols. 

In the case of clustered Sterling B2B Integrator servers, status is monitored for all servers in a 
cluster; however, to avoid duplication, only unique adapter entries are displayed. 

To view the status of the adapters for a Sterling B2B Integrator server:

1. Right-click the Sterling B2B Integrator server.
2. Select Adapter Status Monitor. The Adapter Status Monitor shows information about the 

adapters running on the selected Sterling B2B Integrator server. 

Note: The Server Status Monitor counts a Sterling Connect:Direct PNODE=SNODE Process as 
two sessions. 
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For each adapter, by default the Adapter Status Monitor displays the following information:

View Adapter Properties
You can view all the properties of adapters displayed in the Adapter Status Monitor. 

To view an adapter’s properties:

Double-click the adapter in the Adapter Status Monitor. 

The Service Properties window shows the following additional properties for the selected adapter.

Field Description

# Row number.

On/Off Whether the adapter is currently turned on or off.

State Whether the adapter is currently running or stopped.

Display Name The user-friendly name to display for the adapter.

Environment The nodes on which the adapter is deployed. 

Type The type of adapter.

Perimeter Server The Sterling B2B Integrator perimeter server through which the adapter 
accesses the network. 

PS State The state of the perimeter server this adapter uses to access the network.

Licensed Indicates whether this adapter is licensed or not (true/false).

Protocol The list of protocols that this adapter is configured to work on.

Service Msg The Processing message returned by the adapter/service.

Service Name The unique name for the service. Sterling B2B Integrator uses this name 
internally to reference services.

Status Message The Status message for the adapter/service.

Field Description

Display Name The user configured name for the service/adapter.

Enabled Indicates whether the adapter is currently enabled.

Licensed Whether the adapter is licensed (True/False).

Name The name to display for the adapter.

Node The Sterling B2B Integrator node this adapter is associated with.

Protocol Protocol that the adapter handles.

Service Message System service message. 

Service Name System service name that is used in the business Process.
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View Service Configuration Properties
You can view the properties associated with a Sterling B2B Integrator adapter’s service 
configuration. 

To view service configuration properties:

1. On the Adapter Status Monitor, right-click an adapter.
2. Click Service Configuration. The properties associated with the adapter’s service 

configuration are displayed. Properties vary depending on the specific adapter. 

View Perimeter Server Properties
You can also view the properties of an adapter’s perimeter server. 

To view perimeter server properties:

1. In the Adapter Status Monitor, right-click on the adapter. 
2. Click Perimeter Service Properties.

The properties displayed include the following:

State Whether the adapter is currently running or stopped.

Status Message Detailed adapter status message.

Target Env Cluster nodes deployed on.

Type The type of adapter.

Field Description

Connected Indicates whether Sterling B2B Integrator has established a connection 
with this perimeter server.

Enabled Indicates whether the perimeter service is enabled to execute.

Host Name or IP address of the host where the perimeter server is running.

Last Communication Time The time of the most recent activity between Sterling B2B Integrator 
and the perimeter server.

Name Short name for the perimeter service.

Node Sterling B2B Integrator node this perimeter service is configured to 
communicate with.

Port Port number on which the perimeter server is listening.

Field Description
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Monitor Sterling Connect:Enterprise Daemon Status
In Sterling Control Center, you can monitor master daemon status for selected managed Sterling 
Connect:Enterprise for UNIX servers. The Daemon Status Monitor gives information about the 
UNIX server and reflects simple up or down status.

To monitor UNIX daemon status:

1. Click or Ctrl-click one or more Sterling Connect:Enterprise for UNIX servers.
2. Right-click one of the selected servers and select Daemon Status Monitor. The monitor 

displays daemon status information for all selected servers.

The following table describes the fields displayed in the Daemon Status Monitor. 

Field Description

# Row number. Shows how many master daemons are being monitored.

Name Daemon name.

Type Type of daemon. Sterling Control Center monitors only daemons of type 
master.

Host Host machine the daemon is running on.

PID Daemon Process identifier.

Originator Daemon originator.

Resource Daemon resource.

SID Daemon session identifier.

State Daemon state. 
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Monitor Alerts

This chapter consists of the following:

• About Alerts
• View Alerts
• View an Alerts Snapshot
• Update Alerts
• Customize the Alerts Monitors

About Alerts
An alert is a Sterling Control Center event that is generated and assigned a particular severity level 
when a rule’s criteria are met and an action is performed. An example of an alert would be one that 
informs you that a critical Process may have failed, or that a server may have shut down. Any user 
with appropriate permissions can define rules that trigger alerts. You can then use the Sterling 
Control Center console to view and handle alerts. 

When an alert is present for a server that is online, the alert symbol is displayed over the server icon 
in the Sterling Control Center window. For example, the alert symbol displayed over a Sterling 
Connect:Direct server icon appears as follows:

The alerts monitors (including the Active Alerts Monitor and the Handled Alerts Monitor) provide 
real-time display of alert data as it occurs. These alerts views are updated, based on the console’s 
refresh-rate setting, as new alerts occur and are handled. An alert is listed in one of the alerts 
monitors based upon whether it is active or has already been viewed and designated as handled.

The following table depicts available alert symbols. 

Note: In the table, server event type alerts are displayed over Sterling Connect:Direct icons for illustrative 
purposes only. For events related to FTP, Sterling B2B Integrator, or Sterling Connect:Enterprise 
servers, the same alerts are displayed over the appropriate server icon. 
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Note: The green check shown in the following table means that a comment exists for the alert. Whether 
the alert is handled or not depends on whether it is on the Active or Handled Alerts monitor. The 
comment could have been added when the alert was handled, or a user could have added a comment 
to the alert without handling it. 

Active 
Alert 
Symbol

Handled 
Alert 
Symbol

Description

Server alert symbol. When this symbol is superimposed over a server’s icon in 
the server list, it indicates that an alert is present for the server. 

Sterling Control Center event type alert, severity level 3 - Low

Sterling Control Center event type alert, severity level 2 - Medium

Sterling Control Center event type alert, severity level 1 - High

Server event type alert, severity level 3 - Low

Server event type alert, severity level 2 - Medium

Server event type alert, severity level 1 - High

Connection event type alert, severity level 3 - Low

Connection event type alert, severity level 2 - Medium

Connection event type alert, severity level 1 - High

Process event type alert, severity level 3 - Low

Process event type alert, severity level 2 - Medium

Process event type alert, severity level 1 - High

SLC event type alert, severity level 3 - Low
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View Alerts
You can view the alerts for a server, server group, server type, or for all managed servers. You can 
also view alerts related to servers that are no longer managed and alerts not specifically related to a 
managed server (alerts at the Sterling Control Center level), such as a workflow SLC alert. While 
SLC milestone events are related to a managed server, the workflow events are not. 

You can view the properties of an alert, and you can view the statistics associated with a Process 
related to an alert. You can also view the SLC or rule that generated the alert. 

To view alerts on one server or server group: 

1. Right-click the server or server group.
2. Select Active Alerts or Handled Alerts. 

To view alerts on multiple servers or server groups: 

1. Shift-click the servers or server groups.
2. Right-click one of the selected servers or server groups and select Active Alerts or Handled 

Alerts.

To view alerts on all managed servers of one server type:

1. Right-click the Connect:Direct icon , Connect:Enterprise icon , File Transfer Protocol 
icon , or Sterling B2B Integrator icon .

2. Select Active Alerts or Handled Alerts.

To view alerts on all managed servers:

1. Ctrl-click Connect:Direct, Connect:Enterprise, File Transfer Protocol, or icons, as applicable. 
2. Right-click one of the icons and select Active Alerts or Handled Alerts.

SLC event type alert, severity level 2 - Medium

SLC event type alert, severity level 1 - High

Severity level 0 - in compliance. Level 0 Alerts are handled automatically by the 
Rule Service, so they will never appear in the Active Alerts Monitor.

Note: Users who have roles that are data visibility restricted will see only the alerts associated 
with their data visibility group, whereas unrestricted users will see all alerts.

Active 
Alert 
Symbol

Handled 
Alert 
Symbol

Description
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To view Sterling Control Center-level alerts or alerts not specifically related to a managed server:

1. Right-click the Sterling Control Center icon ( ). 

2. Select Active Alerts or Handled Alerts.
The Active Alerts Monitor or Handled Alerts Monitor window is displayed. You can open 
additional alerts monitor windows as needed.

View Comments
You can view the comments entered for an alert. 

To view the current comment, do one of the following:

• Hover the cursor over the alert. 
• Right-click the alert and click Comments.

To view additional comments: 

1. In the Add Comment window, click the Comment History tab.
2. Select a comment to view. 
3. Click Cancel to exit. 

View Alert Properties
You can view the properties of an alert. 

To view alert properties:

1. From the Active Alerts Monitor or Handled Alerts Monitor window, do one of the 
following to display the Alert Properties window:
• Double-click the alert. 
• Right-click the alert and select Properties. The Alert Properties window shows 

information about the alert. If data is not available for a field, that field is not displayed.
2. Select Close when finished.
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Display a Rule
You can display the rule that triggered an alert.

To display the rule:

1. In the Active Alerts Monitor or Handled Alerts Monitor, right-click the alert.
2. Select View Rule.

The Rule Properties window displays details about the rule. 
See the IBM Sterling Control Center System Administration Guide for an explanation of rules. 

Display an SLC
If an alert was triggered by an event caused by an SLC, you can display that SLC.

To display the SLC: 

1. Right-click the alert in the Active Alerts Monitor or Handled Alerts Monitor.
2. Select View SLC. 

The SLC Properties window displays details about the SLC. 
See the IBM Sterling Control Center System Administration Guide for an explanation of SLC 
properties. 

View an Alerts Snapshot
The alerts monitors provide real-time display of alert data. Monitors are updated as new alerts 
occur, based on console refresh rate. To create an alert view whose data can be sorted, you can 
create a snapshot of the alerts displayed at a given moment in either alerts monitor. 

To create an alerts snapshot:

1. Open the Active Alerts Monitor or Handled Alerts Monitor window.
2. Right-click an alert and select Alerts Snapshot.
3. To close the snapshot, right-click a row and select Close Snapshot.

Update Alerts
You can move an alert from the Active Alerts Monitor to the Handled Alerts Monitor. When you 
move an alert to handled status, you are required to add a comment about the update. You can also 
add comments to the alert before changing its status to handled, and add further comments after the 
status change. You can view the history of comments that have been added to any alert, or print the 
comment history (see the Alerts Report in the IBM Sterling Control Center Reports Guide).
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As you handle alerts in the Active Alerts Monitor, the monitor is replenished until the maximum 
number of displayable alerts is reached. 

To change an alert’s status from active to handled:

1. From the Active Alerts Monitor, right-click the alert and select Handle.
2. Add a comment describing the action taken to handle the alert. 
3. Click Handle Alert(s). 

The comment is recorded, the alert’s status is changed to handled, and the alert is moved to the 
Handled Alerts Monitor listing. 

To add a comment to an alert without handling it:

1. From either the Active Alerts Monitor or the Handled Alerts Monitor, right-click the alert 
and click Comments.

2. In Comment Text, add a summary note of the alert condition’s current status. This note is 
required. Entered by is a display-only field. 

3. Click Add Comment. 

Customize the Alerts Monitors
The alerts monitors provide a large set of information about a server. You can create customized 
views to display only the columns of information that you select. Refer to Customize Layout Views 
on page 51 for instructions on customizing the alerts monitors.

Note: Severity Level 0 alerts are automatically handled by the Rule Service and do not appear in the Active 
Alerts Monitor. They may be viewed in the Handled Alerts Monitor.
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Change Passwords

To change your Sterling Control Center password:

1. Select IBM Sterling Control Center > Change Password.

2. Type your old password. This field is case sensitive. 
3. Type your new password. This field is case sensitive. 
4. Type your new password again.
5. Click Update.
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Chapter 8

View License Information

You can use Sterling Control Center to view server and Sterling Control Center license information.

To view license information for a server:

1. Right-click the server icon and select Properties to display the Server Properties window. 
2. Select the License tab. 
3. This tab displays the type of license, license expiration date, and license key information. Note 

the following items:
• License information is displayed only if the server’s release of Sterling 

Connect:Enterprise, Sterling Connect:Direct, or Sterling B2B Integrator supports sending 
license information to Sterling Control Center. FTP server does not support the display of 
license information. 

• The license expiration date is not shown for Sterling Connect:Enterprise servers that are 
using an emergency key. 

• Sterling B2B Integrator component license information is listed in a table. You can view 
the raw Sterling B2B Integrator license key data by clicking View License Key.

4. Click Cancel to close the window. 

To view Sterling Control Center general, engine, and console information:

1. Select Help > About IBM Sterling Control Center. 
2. Toggle among the General, Engine Properties, and Console Properties tabs. 
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Chapter 9

Customize Layout Views

This chapter contains the following procedures:

• About Customizing Views
• Hide a Column
• Manage Columns
• Rearrange and Resize Columns
• Save a Column Layout
• Select a Column Layout View
• Manage Column Layout Views
• Rename a Column Layout View
• Delete a Column Layout View

About Customizing Views
On Node Discovery, the Queued and Completed Process Activity Monitors, the Handled and Active 
Alerts Monitors, the Adapter Status Monitor, the Daemon Status Monitor, and the SLC, User, 
Roles, Rules, Actions, Schedules, and Calendars listings, a wide variety of information is available 
for viewing. A default view is provided for each tool. You can create a custom view and display 
only selected columns in a view. Once you create a view, you can save it for future use.

You can rearrange the columns to view the information that is important to you, in the order that is 
important. You can create a custom view, hide a column, rearrange columns, save a view, or rename 
a view.
IBM Sterling Control Center User Guide 51



Chapter 9   Customize Layout Views
Hide a Column
You can use the Hide Column feature to hide columns. You can also use Manage Columns to hide 
one or more columns. 

To hide a column: 

Right-click the column heading to hide and click Hide Column.

Manage Columns
You can create custom views for a monitor or listing.

To create a custom view:

1. Right-click a column heading and click Manage Columns.
2. To add a column to the layout, highlight the column name to be added in the Available 

Columns list and click >.
3. To remove a column from the layout, highlight the column name to be removed in the 

Selected Columns list and click <.
4. To rearrange the order of columns, highlight the column to rearrange in the Selected Columns 

frame and click the up or down arrow to move it to a new location. Columns appear in the 
layout in the order in which they appear in the Selected Columns list.

5. Click OK.

Rearrange and Resize Columns
You can rearrange the order of columns in a viewer or monitor, or resize columns. You can also 
automatically resize columns to fit the data being displayed.

To rearrange the order of columns:

Drag a column heading horizontally to the desired position.

To change a column’s width: 

Drag the column heading border until the column is at the desired width.

To resize columns to fit the data being displayed:

Right-click a column heading and click Fit Columns (or press Ctrl+Numeric Pad +).

Note: These settings are saved for each Sterling Control Center user.
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Save a Column Layout
Save a Column Layout
You can save a column layout that you have created. 

To save a new column layout:

1. Right-click any column heading and click Save Layout.
2. Type a name for the new layout in the Layout Name field.
3. Click OK.

Select a Column Layout View
You can select and display column layout you’ve previously defined.

To select a column layout: 

Right-click any column heading and select Select Layout > name of customized layout.

Manage Column Layout Views
You can rename a column layout view or delete a column layout view from the Manage Layout 
window.

Rename a Column Layout View
To rename a column layout:

1. Right-click any column heading and select Manage Layouts.
2. Highlight the layout you want to rename and click Rename.
3. Type a name for the layout in the Layout Name field and click OK.
4. Click Close.

Delete a Column Layout View
To delete a column layout:

1. Right-click any column heading and select Manage Layouts.
2. Highlight the layout you want to remove and click Remove.
3. Click Close.
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Chapter 10

Interface with Other Systems

Sterling Control Center allows for direct access to Sterling B2B Integrator and Sterling 
Connect:Direct. Your access depends in part on your credentials on those other systems. 

This chapter covers the following information:

• Access the Sterling Connect:Direct Browser User Interface 
• Access Sterling B2B Integrator and Sterling File Gateway 

Access the Sterling Connect:Direct Browser User Interface
With authorization, you can access Sterling Connect:Direct from Sterling Control Center through 
the Sterling Connect:Direct Browser User Interface. From this browser-based interface you can log 
onto a Connect:Direct server as a different user or sign onto a Sterling Connect:Direct server as the 
user designated in server properties. From those points you can perform other Sterling 
Connect:Direct user functions. 

Sign onto a Server Using Sterling Connect:Direct Browser User Interface
You can use the Sterling Connect:Direct Browser User Interface to sign onto a selected Sterling 
Connect:Direct server as the user configured in Sterling Control Center server properties.

To sign onto a Sterling Connect:Direct server:

1. Right-click a Sterling Connect:Direct server in the list of servers.
2. Click IBM Sterling Connect:Direct Browser User Interface > Sign On. The Sign On 

Request Response screen displays, along with message indicating whether your request to 
sign on was successful. 

Note: There are three more options on the Connect Direct Browser shortcut menu: InitParms, NetMap, 
and User Auth. These options perform the signon function using the credentials in server properties 
and take the user directly to those pages in Browser.
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Log in as a Different User
You can use Sterling Connect:Direct Browser User Interface to log onto a Sterling Connect:Direct 
server as a user other than the one configured within Sterling Control Center server properties.

To log onto a Sterling Connect:Direct server as a different user:

1. Right-click the Sterling Connect:Direct server.
2. Click IBM Sterling Connect Direct Browser User Interface > Login Page. The Sign On to 

an IBM Sterling Connect:Direct Node screen displays.
3. Supply the following information and click Submit.

• Node
• Userid
• Password
• IP Address
• Port
• Protocol 

Access Sterling B2B Integrator and Sterling File Gateway
With authorization, you can access Sterling B2B Integrator and Sterling File Gateway from Sterling 
Control Center.

To access the Sterling B2B Integrator Dashboard and sign onto a Sterling B2B Integrator server as 
the user designated in server properties:

1. Right-click the Sterling B2B Integrator server.
2. Select Sterling B2B Integrator Dashboard > Sign On.

The Admin Console Home screen displays. 

To access Sterling File Gateway:

1. Right-click the Sterling File Gateway server.
2. Select Sterling File Gateway > Login Page.
3. Provide valid Sterling File Gateway credentials and click Sign In.

Note: For information on using Connect:Direct Browser, see the Connect:Direct Browser documentation. 

Note: The Dashboard port value in Server Properties (Connection tab) must be specified; otherwise, the 
Sterling B2B Integrator Dashboard option cannot be used. 

Note: For information on administering Sterling B2B Integrator via the Sterling B2B Integrator 
Dashboard, consult the Sterling B2B Integrator documentation.
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Appendix A

User Troubleshooting

The following table identifies issues you may experience in using Sterling Control Center, along 
with solutions to fix each issue. This appendix is a subset of the more comprehensive 
troubleshooting appendix found in the IBM Sterling Control Center System Administration Guide. 

Issue Solution

Queued Activity Monitor does not show the 
current executing Process.

• If you are running Processes with numerous copy steps, 
IBM® Sterling Control Center may not show the current 
status due to the large number of statistics records 
generated. You can disable collecting IBM® 
Connect:Direct® step statistics. 

• Fast-running Processes may complete before they are 
shown in the Queued Activity Monitor.

• IBM® Connect:Enterprise® and FTP Processes are never 
shown in the Queued Activity Monitor because information 
about those Processes is not known until the Process 
completes. 

• Set a lower Monitor Rest Time setting in the Server 
Properties window.
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Alerts for SLC events do not show in Alerts 
Monitor. 

•Verify that a rule to generate an alert from an event has been 
created. See Manage Rules and Actions in the IBM Sterling 
Control Center System Administration Guide for more 
information. 

• Verify that the rule and SLC are enabled and correct. 
• Workflow SLC alerts can only be seen in an alerts monitor 

opened on Control Center, not on an individually managed 
server.

• Verify alert is not restricted to a data visibility group for which 
the user has no authority.

• Verify rule is not restricted to a data visibility group that does 
not have visibility of the events.

• Because SLCs with wildcard server expressions can 
generate alerts for events that did not occur, you can only 
see these types of alerts in an alerts monitor opened on 
Control Center, not on an individually managed server.

• Verify the Severity Level of the Alert being generated. Level 
0 Alerts do not appear in the Active Alerts Monitor, but are 
automatically moved to the Handled Alerts Monitor by the 
Rule Service. You may change the Alert level for an event by 
editing the Rule.

• See Troubleshoot SLCs in the IBM Sterling Control Center 
How-To Guide for more information.

Cannot log on using HTTPS. Verify that you are logging on with the host name used to set up 
the HTTPS connection. See Configure a Secure Connection in 
the IBM Sterling Control Center Getting Started Guide for more 
information.

One or more Sterling Control Center functions are 
dimmed and cannot be selected. 

Your Sterling Control Center role does not have permission to 
perform the functions in question. Your system administrator can 
change your role if necessary. 

Sterling Control Center does not recognize 
daylight saving time change.

• Verify that you have selected a time zone that supports 
daylight saving time in the server definition or in the time 
preferences. 

• If you use UTC time for Sterling Control Center time displays, 
you must manually adjust the UTC time to daylight saving 
time. UTC time never changes for daylight saving time. 

Sterling Control Center ignores certain 
Connect:Direct commands.

• Verify that Control Center is logging the appropriate statistics 
records. For a list of statistics records used by Control 
Center, see Event Type Descriptions in the IBM Sterling 
Control Center System Administration Guide. 

• Use the Server Properties window to verify that the user ID 
that accesses the Connect:Direct server has the 
authorization required to issue the commands.

WARNING: Could not create system preferences 
directory. System preferences are unusable. 
message received when starting the GUI on 
Linux.

Verify that the user has Read and Write permission to the 
../etc/java directory.

Issue Solution
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Suspending a Process results in a blank screen 
followed by CNCD017E Suspend process failed. 
message. 

The Process has already completed.
Fast-running Processes may complete and others may begin to 
run before the Completed Activity Monitor is updated. 

Window text is not clear in UNIX X Windows 
environment. 

This problem is related to how a UNIX X Windows environment 
handles font display. Refer to your UNIX documentation to 
resolve display problems.

A client computer that runs the Console via 
Webstart is running out of disk space. 

From time to time, manually delete the log files (in the format 
SCClient_xxxxxxxxxxx.log) from the client computer’s root 
directory. 

Cannot launch Console using Web Start. In Microsoft Windows, take the following steps:
• Select Start > All Programs > Java Web Start.
• Select  File > Preferences.
• On the Preferences’ General tab, change Proxies to "None" 

and click OK.

The Sterling Control Center Console is not 
connecting to the engine.

Make sure that the engine is running on the host and port that 
you specify on the login screen.

In monitoring FTP servers, the servers appear to 
go off and back online continuously. 

This situation occurs when multiple Control Center engines 
monitor an FTP server through the same agent. If more than one 
engine is monitoring an FTP server, make sure that each engine 
uses its own FTP agent. 

Issue Solution
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Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently 
available in your area. Any reference to an IBM product, program, or service is not intended to state 
or imply that only that IBM product, program, or service may be used. Any functionally equivalent 
product, program, or service that does not infringe any IBM intellectual property right may be used 
instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You can 
send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where 
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
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FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied 
warranties in certain transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions of 
the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do 
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are 
not part of the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including 
this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including in some 
cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may 
have been made on development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some measurements may have been 
estimated through extrapolation. Actual results may vary. Users of this document should verify the 
applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products 
and cannot confirm the accuracy of performance, compatibility or any other claims related to 
non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to change before 
the products described become available. This information contains examples of data and reports 
used in daily business operations. To illustrate them as completely as possible, the examples include 
the names of individuals, companies, brands, and products. All of these names are ficticious and 
any similarity to the names and addresses used by an actual business enterprise is entirely 
coincidental.
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COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrate 
programming techniques on various operating platforms. You may copy, modify, and distribute 
these sample programs in any form without payment to IBM, for the purposes of developing, using, 
marketing or distributing application programs conforming to the application programming 
interface for the operating platform for which the sample programs are written. These examples 
have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply 
reliability, serviceability, or function of these programs. The sample programs are provided "AS 
IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use 
of the sample programs. 

Each copy or any portion of these sample programs or any derivative work, must include a 
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. 
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may not 
appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business 
Machines Corp., registered in many jurisdictions worldwide. Other product and service names 
might be trademarks of IBM or other companies. A current list of IBM trademarks is available on 
the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and 
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel 
Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel 
Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft 
Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office of Government 
Commerce, and is registered in the U.S. Patent and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle 
and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, 
other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of HP, IBM 
Corp. and Quantum in the U.S. and other countries.
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Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®, Gentran:Basic®, 
Gentran:Control®, Gentran:Director®, Gentran:Plus®, Gentran:Realtime®, Gentran:Server®, 
Gentran:Viewpoint®, Sterling Commerce™, Sterling Information Broker®, and Sterling 
Integrator® are trademarks or registered trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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